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( 50 ............................................................................................... هدف دستگاه یزیر برنامه 00-5) شکل
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خواهیم پرداخت. برای این  Quartus II افزار نرماستفاده از  ی در این راهنما به بررسی نحوه

 .پردازیم می ها آنکار با  ی نحوههای مختلف و  به بررسی بخش کار قدم به قدم

آشنا نبوده و یا افرادی  افزار نرمبدیهی است گفتار پیش رو برای آن دسته از افرادی که با این 

 هستند مفید خواهد بود. افزار نرمکه خواهان بازیابی اطلاعاتشان در مورد این 

شوید، در  میبا مبانی ایجاد یک طراحی آشنا  0و  9در فصل . فصل خواهیم داشت 4در ادامه 

سازی  پیاده 5فصل  یآموزید و در نهایت با استفاده از راهنمای میسازی طراحی را  روش شبیه 4فصل 

 طراحی را فرا خواهید گرفت. 
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برای کنیم.  را طی می HDLافزاری بر اساس  یک واحد سخت فرآیند طراحی ،در این فصل

توانید  کنیم. با این مثال به راحتی می را انتخاب می 0کامل ی کننده جمع مانند این کار یک مثال ساده

ی خود را با مدار تولید شده بیابید. در این مثال، ما از زبان توصیف  ارتباط کُد نوشته شده

ایم. لازم به ذکر است که مراحل لازم برای سنتز،  برای مدار خود بهره گرفته Verilogافزاری  سخت

 باشند. مستقل از زبان انتخاب شده می

 Quartusباز کردن  -2-1

ها مختص  شما ظاهر شده که یکی از آن  Desktopافزار دو آیکون بر روی با تکمیل نصب نرم

ی ویندوز شما یکی از  باشد. بسته به نسخه بیتی مناسب می 64بیتی بوده و دیگری برای  09ویندوز 

ی  ی برنامه با نسخه ها اجرا شده و با انتخاب دیگری خطایی مبنی بر عدم تطابق نسخه این گزینه

 گردد. ویندوز شما اعلام می

 ساخت پروژه جدید -2-2

File -> New Project Wizard  کند. ابتدا  ی مربوط به ساخت پروژه را باز می پنجره

توان با  شود که می برای تکمیل ساخت یک پروژه نمایش داده می رو ی پیش ای از پنج مرحله مقدمه

9ی مقدمات عدم نشان دادن دوباره "ی  گزینهانتخاب 
مجدد این پنجره در مراجعات بعدی  از نمایش "

                                           
0 Full Adder 

9 Don’t show me this introduction again 
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ی  ی بعد، اطلاعات موردنیاز برای ساخت پروژه ین بخش، جلوگیری کرد. پس از ورود به مرحلهبه ا

 شود.  موردنظر از شما پرسیده می

 

(1-2) شکل ی ساخت پروژه مقدمه 

چنین نام طراحی سطح بالای موردنظر برای  ی آن و هم نام پروژه، محل موردنظر برای ذخیره

بایست به طور  گردد. لازم به ذکر است که این نام می میاین پروژه، در این مرحله از شما درخواست 

 دقیق با نام ماژول یا موجودیت تعریف شده در طراحی شما یکسان باشد.
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(2-2) شکل انتخاب نام برای پروژه 

باشند به  و موردنیاز این پروژه میاند  های موجود را که پیشتر نوشته شده توان فایل در این مرحله می

باشد.  پذیر می امکان به پروژه در هر زمان دیگری نیز  ذکر است که افزودن فایلآن اضافه نمود. شایان 
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(3-2) شکل افزودن فایل به پروژه 

اید، انتخاب نمایید.  مقصدی را که برای سنتز طراحی خود در نظر گرفته در این بخش دستگاه

گردند. در این بخش  باشد که بسته به نیاز کاربر تنظیم می های متعددی می این مرحله شامل گزینه

 افزار بسنده کرد و بر این اساس باقی مراحل را ادامه داد. فرضِ نرم توان به تنظیمات پیش می
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(4-2) شکل ه مقصدانتخاب دستگا 

، در این مرحله Quartusافزار  در نرم EDAدر صورت نیاز به استفاده از دیگر ابزارهای 

 ها را تعیین نمایید.    بایست آن می
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(5-2) شکل EDAانتخاب  

در نهایت تمامی تنظیمات معین شده برای پروژه، به صورت خلاصه در این مرحله به نمایش 

 شوند. گذاشته می
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(6-2) شکل خلاصه ساخت پروژه 

توانید از تعریف شماتیک آن استفاده  طور که پیشتر بیان کردیم برای سنتز مدار خود می همان

مراحل سنتز توصیف نمایید. در این بخش  HDLهای  که مدار خود را با زبان کنید و یا آن

 2-9مدار به صورت شکل  کنیم. نوشته شده است را بیان می Verilogکه به زبان ی کامل  کننده جمع

 یف شده است:توص

(7-2) شکل کننده افزاری واحد جمع توصیف سخت 
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را به آن اضافه نمودیم  و از  FA، فایل my_projectی  در گام پیشین، هنگام ساخت پروژه

-topایم هنگام ساخت پروژه نیز نام  گذاری کرده نام FA، ماژول خود را Verilogجا که در کُد  آن

level design  راFA  .نهادیم 

های  استفاده کرد و از میان فایل File -> New  توان از مسیر مدار می برای توصیف یک

را انتخاب نمود و یا آن که  VHDLیا  Verilogهای  ای که در اختیار گذاشته شده یکی از زبان طراحی

 دیاگرام یا همان شماتیک بهره برد.  از تعریف مدار به شکل بلوک

 

(8-2) شکل اضافه کردن فایل جدید 

برای  کنید. کامپایلتوانید آن را  های موردنیاز به پروژه، اکنون می ن فایلپس از اضافه نمود

 را اجرا کنید. Processing -> Start Complilationاین کار 

در صورتی که خطایی در کُد شما وجود نداشته باشد، این مرحله بدون مشکل پایان یافته و 
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که در  شوند در حالی ای به نمایش گذاشته می در انتها نتایج حاصل از سنتز به صورت خلاصه درپنجره

ها، تعداد  پذیرد و در قسمت مربوط به پیغام صورت وجود خطا، این مرحله به درستی پایان نمی

شوند. با کلیک بر روی هر یک از این خطاها، به خط  خطاهای موجود در کُد شما نشان داده می

 دن تمامی خطاها دوباره مدارتان را کامپایل کنید. شود. با برطرف نمو مربوطه در کُد ارجاع داده می

 

(9-2) شکل )حالت کامپایل پروژه بدون خطا( Quartusپنجره  

باشد.  قابل مشاهده می 0ی روند خلاصهاطلاعات مهم سنتز به صورت خلاصه دربخشی با نام 

ای که برای سنتز استفاده شده، Quartusافزار  ی نرم این اطلاعات شامل وضعیت سنتز، نسخه

های موردنیاز  که به عنوان بُرد مقصد در نظر گرفته شده، تعداد کل المان FPGAاز بردهای  ای  خانواده

های ترکیبی مورد نیازِ مدار  ها و المانثباتبرای ساخت مدار مورد نظر بر روی بُرد انتخاب شده، تعداد 

 01-9شکل در  کننده جمعحاصل از سنتز مدار  ی روند خلاصهباشد.  و اطلاعاتی از این دست می

                                           
0 Flow Summary 
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 آورده شده است.

 

(10-2) شکل کننده خلاصه اطلاعات سنتز جمع 

در اختیار شما  0لیست گره نمایهایی که  توانید از قابلیت مدار خود میخطایابی برای آنالیز و 

دهد، بهره ببرید. این بخش تنها زمانی که کامپایل مدارتان با موفقیت پایان پذیرد به نمایش در  قرار می

نشان داده شده است.  00-9گردد. چگونگی دسترسی به این بخش در شکل  فعال می آمده و

9نمای های شود این قسمت دارای سه زیر شاخه با نام طور که مشاهده می همان
RTL ،  نمای ماشین

 باشد. می 4نمای تکنولوژی ترسیمو  0حالت

                                           
0 Netlist Viewer 

9 RTL Viewer 

0 State Machine Viewer 

4 Technology Map Viewer  
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(11-2) شکل انواع نماها 

 RTL نمای  -2-2-1

باشد و این امکان را  ی مناسبی می سنتزِ مدار گزینه ی نتایج حاصل از این گزینه برای مشاهده

ها با  ی اتصال آن های منطقی و نحوه آورد تا تشخیص دهید که، به لحاظ المان برای شما فراهم می

افزار تفسیر شده است یا خیر. در حقیقت شماتیک مدار شما به  یکدیگر، آیا مدار به درستی توسط نرم

توان  می نمای ماشین حالتو   RTLنمای بل مشاهده است. ازصورت گرافیکی در این بخش قا

ی  ی دیگری، به صورت چشمی بررسی نمود. مشاهده استفاده کرد و مدار را پیش از انجام هر پروسه

کند تا مدار خود را آنالیز کرده و منشأ خطاهای طراحی را بیابید و  مدار طراحی شده به شما کمک می

ها  درست باشد، خواهید دانست که آنالیز خود را بر روی دیگر قسمتآن   RTLنمایدر صورتی که 

مانند آنالیز زمانی متمرکز نمایید. لازم به ذکر است که این شماتیک، ساختار نهایی مدار شما نبوده و 

ها هنوز بر روی آن اعمال  سازی که بهینه کشد؛ چرا شما را به تصویر می ی بیشتر طراحی اولیه

افزار از توصیف ما به  توان به راحتی به مداری که نرم ر واقع به کمک این بخش میاند. د نگردیده
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تر باشد و به جای ساختاری به صورت رفتاری  دست آورده پی برد. هر چه مدار توصیف شده پیچیده

این گونه مدارات به  RTLگردد. چراکه با تولید  تر می توصیف گردیده باشد، نقش این بخش پر رنگ

را  ها توان به چگونگی مدارِ سنتز شده پی برد و در صورت نیاز، کُد نوشته شده برای آن میسادگی 

 تغییر داد.

کننده  جمعجا که  تولید گردیده است. از آن 09-9به شکل  ی موردنظر کننده جمع RTLنمای 

 09-9شکل کاملاً به صورت ساختاری توصیف شده، تناظر یک به یکی میان کُد مربوطه و مدار 

رقم نقلی برای ساخت  ورودیسه  ORدو ورودی و یک گیت  ANDشود. سه گیت  مشاهده می

وجود دارند به راحتی  09-9که در شکل  جمع حاصلسه ورودی برای  XORو یک گیت  خروجی

 با توصیف مدار مطابقت دارد. 

 

(12-2) شکل کننده برای جمع RTLنمای  

 نمای ماشین حالت  -2-2-2

دهد. این بخش  های موجود در طراحی به شما می این قسمت دید مناسبی از ماشین حالت

 دهد.  های موجود در مدار ارائه می ماشین حالتها و گذارهای  یک نمایش گرافیکی از حالت
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باشد، هیچ ماشین حالتی برای آن تولید نخواهد  مداری ترکیبی می کننده جمعجا که مثال  از آن

 شد.

 تکنولوژی ترسیمنمای  -2-2-3

دهد.  این قسمت نیز یک نمایش گرافیکی و وابسته به تکنولوژی را در اختیار طراح قرار می

های  طراحی شما مانند سلول 0ی های پایه به صورت سلسله مراتبی، بخشنمای تکنولوژی ترسیم 

ها  انوادهدهد و برای برخی از خ های ورودی/خروجی را نمایش می چنین پورت و هم ستگاهمنطقی د

LUTها و  ثباتی  امکان مشاهده
وه بر آن به شما کند؛ علا ها را نیز فراهم می های داخل این سلول9

 ورودیهای  توان از پورت یابی کنید. به این ترتیب که می ها را پس از سنتز مکان گرهکند تا  کمک می

که به صورت سلسله  نو خروجی طراحی شروع کرده و به سمت جلو یا به عقب حرکت کنید و یا آ

دلخواه خود دست یابید و یا با بررسی  گرهمراتبی در سطوح مختلف طراحی جستجو کرده تا به 

به   کننده نمای تکنولوژی ترسیم برای مدار جمعبخصوص را پیدا نمایید.  ثباتشماتیک طراحی، یک 

 ای بخش پایههای آبی رنگ نشان داده شده در شکل،  به هریک از المان .باشد می 00-9شکل صورت 

باشند و جزییات بیشتری را نیز  ها و نوع اتم می شود که هر یک دارای نام اتم، نام پورت گفته می

 شوند. شامل می

                                           
0 Atom Primitive 

9 Look Up Table 
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(13-2) شکل کننده نمای تکنولوژی ترسیم برای جمع 

تر شد و  توان یک مرحله دقیق میهای نشان داده شده  که با کلیک بر روی هر یک از المان

 بدین ترتیب به جزییات بیشتری دسترسی پیدا کرد. 

 

توان به  می 0ها ویژگیی  و انتخاب گزینه ای ی پایهها بخشبا کلیک راست بر روی  هر یک از 

تری از آن اتم دسترسی پیدا کرد. این اطلاعات بسته به ماهیت اتم انتخابی متفاوت  یاطلاعات جزئ

                                           
0 Properties 
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ی هابافرو دیگری  0ی منطقیها سلولدو دسته اتم وجود دارند: یکی  کننده در مثال جمعبود.  خواهند

 .  9ورودی و خروجی

ی ها ، ویژگیدر نظر گرفته شده XORکه معادل با  جمع حاصلمربوط به  سلول منطقیبرای 

 نشان داده شده است. برای این اتم چهار مشخصه وجود دارند: زیر

 شماتیک 

 .کلیک بر روی اتم، جزییات این قسمت را مشاهده کردیمپیشتر با 

 جدول درستی 

 .دهد ها، مقدار خروجی را نشان می در ازای مقادیر مختلف برای ورودی این جدول

 جدول کارنو 

 .باشد نمایش گرافیکی جدول درستی میاین جدول     

 ها پورت 

بودن  4فعال پایینو یا  0بالافعال های ورودی/خروجی اتم موردنظر را نشان داده و  پورت

  .نماید هر یک را مشخص می

ی شماتیک و پورت وجود  های موجود تنها دو مشخصه این در حالی است که برای پورت

 دارد.

                                           
0 Logic Cell 

9 I/O Buffer 

0 Active High 

4 Active Low 
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(14-2) شکل های اتم انواع مشخصه 

همواره نتایج آخرین کامپایلی را که با موفقیت انجام شده است،  تمام این نماهاشایان ذکر است که 

د. بنابراین اگر شما طراحی خود را تغییر داده به طوری که در فاز آنالیز آن خطایی حاصل ده نشان می

مربوط به این طراحی را مشاهده کنید ولی هنوز قادر خواهید بود تا نتایج  لیست گرهتوانید  شود، نمی

 ی طراحی خود را ببینید.   ی کامپایل شده حاصل از آخرین نسخه
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 .پردازیم میای  ی کتابخانهها جاد یک طراحی بر اساس اتصال بلوکبه توضیح ای فصلدر این 

افزار  های دیگر نرم کنیم تا با این مثال، ویژگی استفاده می کننده جمعبنابراین این بار از شماتیک مدار 

Quartus ی جدید با نام  به طریقی که در فصل چهارم توضیح دادیم، یک پروژه را نشان دهیم.  درابتدا

FA_Shematic سازیم. به  میFile > New فایل شماتیک را از 0یاگرامی بلوک د رفته و این بار گزینه /

 کنیم. انتخاب می 9های طراحی زیر گروه فایل

 

(1-3) شکل طراحی شماتیک ی پنجره 

بایست با کنار هم قرار دادن تمامی اجزای موردنیاز، مدار موردنظر را ساخت.  حال می

جمع همراه است. بنابراین  و حاصل  کننده با تعریف رقم نقلی خروجی دانیم که عملیات این جمع می

مشخص شده است را از نوار ابزار  ANDرا که با نماد گیت  0ابزار نماد های لازم، برای چیدن گیت

                                           
0 Block Diagram 

9 Design Files 

0 Symbol Tool 
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 0ها و پایه 9، غیره0های توابع اصلی ی اصلی با نام شود سه دسته طور که مشاهده می انتخاب کنید. همان

مورد نظر،  های به نوع المان بستهشوند.  ا شامل میهای دیگری ر  گروهوجود دارند که  هریک زیر 

 ها گشته و اجزای مربوطه را انتخاب نماید.    تواند میان هر یک از این گروه طراح می

     

(2-3) شکل ها انتخاب گیت از کتابخانه 

و  AND ،ORهای منطقی پایه از قبیل    ی خود به گیت کننده جا که ما برای مدار جمع از آن

XOR  نماییم. توجه  ها را انتخاب می مراجعه کرده و آن ها پایهاز بخش  4منطقینیازمندیم، به زیر گروه

دی وروهای  بایست از پورت های مدار نیز می و خروجی ها دیاین نکته ضروری است که برای ورو به

 باشند.  می قابل دسترس پینو زیر بخش  ها پایهها نیز در بخش  یا خروجی استفاده کرد. این پورت

                                           
0 Megafunctions 

9 Others 

0 Primitives 

4 Logic 
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(3-3) شکل کننده انتخاب اجزای جمع 

ها را به درستی برقرار  میان آن  بایست ارتباط پس از انتخاب تمامی اجزای موردنیاز، حال می

 کرد.

(4-3) شکل کننده برقراری ارتباط بین اجزای جمع 

سپس  و کنیم وذخیرهبایست ابتدا این فایل را  حال برای کامپایل کردن مدار ساخته شده می

. در صورتی که مشکلی در ارتباطات و یا هر بخش دیگری از مدار ی خود بیافزاییم وژهآن را به پر
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مشاهده  ی روند خلاصهی نتایج سنتز را مشابه قبل در قسمت  توان خلاصه وجود نداشته باشد، می

 کرد.
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 شبیه سازی رفتاری
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Quartus II  کند. ما نیز در این  سازی مدارات طراحی شده را برای شما فراهم می امکان شبیه

و هم به منظور اطمینان حاصل کردن  Quartusافزار  قسمت، هم به منظور توضیح این ویژگی در نرم

 سازی کردیم. ی خود را شبیه کننده از درستی عملکرد طراحی، جمع

های طراحی به بخش  مراجعه کرده ولی این بار به جای فایل File->Newباز هم به منوی 

VWFریزی دانشگاهی  ی برنامه رفته و گزینه 0یابی سنجی/درستی های درستی فایل
کنیم  را انتخاب می 9

 شود.  ی مربوط به شکل موج باز می و بدین ترتیب پنجره

 

 موج پنجره شکل (1-4) شکل

های موردنیاز در طراحی را انتخاب  گرهکنیم. بدین ترتیب که  سپس به صورت زیر عمل می

/خروجی و یا هر موجودیتی را که خواستار حضور آن در ورودیهای  ها یا پورت کرده و سیگنال

 افزاییم.  خود می شکل موجسازی هستیم را  به  شبیه

                                           
0 Verification/Debugging Files 

9 University Program VWF 
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 های دلخواه انتخاب گر (2-4) شکل

و خروجی نیازمندیم،  ورودیهای  تنها به پورت کننده جمعجا که برای بررسی عملکرد  از آن

های موجود در مدار را نمایش  پینتنها لیست  کنیم که ای تنظیم می را به گونه 0ی گره یابنده بنابراین 

 دهد. 

                                           
0 Node Finder 
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 ها انتخاب ورودی و خروجی برای لیست پین (3-4) شکل

کنیم.  خود اضافه می موج صفحه شکلها را به  ی آن های موردنظر، همه گرهبا انتخاب تمامی 

ها  وجیها و بررسی خر  سازی آماده بوده و تنها مقدار دهی به ورودی بدین ترتیب همه چیز برای شبیه

 ماند.  باقی می

 ها حالت اولیه شکل موج (4-4) شکل

را مقداردهی نماییم. به این منظور  cinو  a ،bهای  حال نوبت آن است که هر یک از سیگنال
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های مختلفی که در نوار ابزار تعبیه  بخشی از سیگنال موردنظر را انتخاب کرده و با استفاده از گزینه

 دهیم. ها نسبت می ... را به آن شده، مقادیر صفر، یک، امپدانس بالاو

 ها مقداردهی سیگنال (5-4) شکل

. اندازی کنید با مقدیر داده شده راه بایست مدار را ها، می ی مقادیر خروجی حال برای مشاهده

 د، لازم است که آن را ذخیره نمایید.  سازی کنی شبیهمدار را  یدالبته پیش از آن که بتوان

0سازی عملکردی شبیهی  سازی دو گزینه برای شبیه
پیش رو خواهید  9سازی زمانی ئ شبیه  

آل بودن عملکرد اجزا، مورد مطالعه قرار می  داشت که در حالت اول تنها عملکرد مدار در حالت ایده

سازی واقعی با در نظر گرفتن تاخیرهای زمانی و سایر ملاحظات  گیرد، اما حالت دوم در شرایط پیاده

 گیرد. انجام می

                                           
0 Functional 

9 Timing 
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 سازی ی عملکردی شبیهاجرا  (6-4) شکل

امکان پذیر است. به عنوان مثال در  FPGAهای  سازی تنها برای برخی از خانواده نکته: شبیه

  اید  افزار استفاده نموده مقصد از تنظیمات پیش فرض نرم ستگاهصورتی که در زمان تعیین د

)GX IV Cyclone(سازی به درستی انجام نخواهد پذیرفت.  شبیه 

و غیر قابل تغییر نمایش داده   ی جدید در قالب یک پنجره سازی شبیهی  نتیجهدر نهایت  

 شود. می

 

 سازی نتیجه شبیه (7-4) شکل
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باشد، با  ها وابسته می ورودیجا که مثال در نظر گرفته شده مداری ترکیبی بوده و تنها به  از آن

د به سادگی گیرن به خود می Coutو  Sumبررسی مقادیری که در هر لحظه دو سیگنال خروجی 

 کننده، ببریم. ی خود، به عنوان یک مدار جمع توان پی به عملکرد صحیح شماتیک ساخته شده می
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در این راهنما  است. 4و مسیر یابی 0، جایابی9، ترسیم0سازی فرآیندی شامل ترجمه پیاده

ای از شرکت FPGAهر  5ریزی شود. اما روند مشابهی برای برنامه انجام می DE2سازی روی برد  پیاده

ALTERA  درQuartus  پردازیم. قسمت به آن می تعریف شده است که در این 

 6انتخاب دستگاه هدف  -5-1

تغییر  DE2در ابتدای کار بایستی دستگاه مقصد را از حالت پیش فرض به دستگاه مقصد برد 

دهید. می توانید این کار را در ابتدای زمان تعریف پروژه انجام دهید و یا اگر از آن مرحله عبور 

بروید. در این پنجره در  0-5ای مشابه شکل  به پنجره Assignment > Deviceکردهاید از طریق 

 را بزنید. 2را انتخاب کنید و تایید EP2C35F672C6و برای نوع دستگاه  Cyclone IIقسمت خانواده 

 

 

                                           
0 Translate 

9 Map 

0 Place 

4 Route 

5 Program 

6 Target Device 

2 OK 
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(1-5) شکل انتخاب دستگاه 

 تخصیص پین -5-2

های  دارای تعداد پین DE2جا که برد  پین انجام شود. از آن 0فرآیند تخصیص این قسمت در

ها  آماده که لیست تمام پین Excelبسیاری است، برای انجام عمل تخصیص پین می توان از یک فایل 

 را داراست استفاده کرد و یا اینکه به صورت دستی این عملیات را انجام داد. 

                                           
0 Assignment 
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 روش استفاده از فایل آماده تخصیص پین با -5-2-1

 Assignments > Import Assignmentاز طریق  Quartusدر  Excelبرای استفاده از فایل 

 فایل ذکر شده را وارد کنید. 

 

(2-5) شکل Excelوارد نمودن فایل  

گذاری  استفاده می کنید نام Excelای که وجود دارد این است که اگر از فایل  تنها نکته

بخواهید ننده ک به عنوان مثال اگر در جمع .فایل مربوطه باشد یگذار ها باید بر اساس نام پورت

ها مشاهده کنید، باید  LEDها را توسط  های برد اعمال کنید و خروجی ها را توسط سویچ ورودی

 ورت زیر تغییر دهید.صبه  Verilog  ها را در بخش گذاری پورت نام

 

(3-5) شکل Excel(1)گذاری در فایل  ها با توجه به نام تغییر نام پورت 

متغیر است که تغییر نام تمامی آنها کار  در صورتی که طراحی شما دارای تعداد زیادی

گرفته و در داخل به  Excelها را با اسامی فایل  بری باشد می توانید ورودی زمان
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های واحد را گرفته و به  های واحد خودتان تخصیص دهید. در آخر هم ورودی ورودی

 های خروجی وصل کنید. پورت

  

(4-5) شکل Excel(2)فایل  گذاری در ها با توجه به نام تغییر نام پورت 

 تخصیص پین باروش دستی -5-2-2

صفحه مربوط به تخصیص پین را باز  Assignments > Pin Plannerدر این روش از طریق 

 است. 5-5کنید. این صفحه مشابه شکل
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(5-5) شکل ی تخصیص پین پنجره 

ها پین اختصاص دهید. در  ها وجود دارد که باید به آن در قسمت پایین پنجره لیست پورت

ایم در مقابل هر پین موقعیت آن هم تعریف شده  را وارد کرده Excelاز آنجا که قبلا فایل  5-5شکل

 ها را تغییر دهید. است که در این قسمت می توانید آن

در نهایت یک بار دیگر طراحی خود را کامپایل نمایید تا از درست بودن عملیات تخصیص 

 ی خود مطمئن شوید. پین و اعمال آن به پروژه

 ریزی دستگاه برنامه -5-3

از  های توان و اتصال به کامپیوتر برد را وصل کنید. سپس ابتدا سیم ریزی دستگاه برای برنامه
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در صورتی که برای اولین بار است که را باز کنبد.  ریزی پنجره برنامه Tools > Programmerطریق 

افزاری وجود ندارد  هیچ سخت 0افزار برد را به کامپیوترتان وصل می کنید در قسمت  تنظیمات سخت

افزار برد را نصب کنید. برای این کار ابتدا روی کامپیوتر  مربوط به سخت 9درایوردر این شرایط باید 

-USBی باز شده، روی  را انتخاب کنید. سپس در پنجره 4راست کلیک کرده و گزینه مدیریت 0من

Blaster .کلیک کنید 

 

5ی مدیریت کامپیوتر پنجره 
(6-5) شکل 

 درایور را بزنید. 0ی به روز رسانی ی باز شده گزینه پنجره سپس در

                                           
0 Hardware setup  
9 Driver 

0 My Computer 

4 Manage 

5 Computer Managment 
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(7-5) شکل نصب درایور 

 ی نصب دستی درایور را انتخاب کنید. در نهایت گزینه

                                                                                                                            
0  Update 
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(8-5) شکل افزار نصب دستی نرم 

-USBی  ) و یا هر مسیری که شما را به پوشه 2-5در نهایت مسیر نشان داده شده در شکل 

Blaster را انتخاب کنید. می رساند. را وارد نموده و بعدی 
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(9-5) شکل USB-Blasterی  مسیر پوشه 

افزار از شما خواسته می شود که با دادن این اجازه درایور نصب  ی نصب نرم در نهایت اجازه

 خواهد شد.

 

(10-5) شکل اجازه نصب درایور 



 سازی پنجم: پیادهفصل                                                 Quartusراهنمای استفاده از نرم افزار

 

 

42 Copyright © 2013 ICEEP, University of Tehran                                                            

را باز کنید و روی تنظیمات   Quartusریزی در  پس از انجام این مرحله دو باره صفحه برنامه

را انتخاب  USB-Blaster [USB-0]ی  گزینه 0افزارهای موجود سخت افزار بروید و در بخش سخت

 کنید.

 

(11-5) شکل افزار انتخاب سخت 

پس از آن باید فایل پروژه خود را به این قسمت اضافه کنید. بنابراین روی گزینه افزودن 

 sof.با نام طراحی شما و با پسوند  دنبال فایلی 0یکلیک کرده و در بخش فایل های خروج  9فایل

 بگردید و آن را باز کنید.

                                           
0 Available Hardwares 

9 Add File 

0 Output Files 
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(12-5) شکل ریزی انتخاب فایل برنامه 

ریزی  را بزنید. اگر در روند برنامه 0ی شروع آن را انتخاب و گزینه ی اصلی آن فایل سپس در صفحه

 خطایی وجود نداشته باشد عملیات با موفقیت انجام خواهد شد.

 

                                           
0 Start 
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(13-5) شکل ریزی دستگاه هدف برنامه 

آشنا شدید و  Quartusرسد. شما تا اینجا با عملیات پایه ای در  در این مرحله کار به اتمام می

برد آن را تست کنید. برای کسب اطلاعات بیشتر  یتوانید سخت افزار خود را طراحی و رو می

 مراجعه کنید. www.ICEEP.irتوانید به سایت  می

http://www.iceep.ir/
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A 

Active High فعال بالا 

Active Low فعال پایین 

Add File  فایلافزودن 

Assignment تخصیص 

Atom Primitive ای های پایه بخش 

Available Hardwares سخت افزارهای موجود 

B 

Block Diagram بلوک دیاگرام 

C 

Combined Files های ترکیبی فایل 

Computer Managment مدیریت کامپیوتر 

D 

Debugging یابی درستی 

Design File فایل طراحی 

Device دستگاه 

Driver درایور 

Download Selected File های انتخابی دانلود فایل 
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E 

F 

Finish اتمام 

Flow Summary ی روند خلاصه 

Full Adder کننده جمع 

Functional عملکردی 

G 

H 

Hardware Setup افزار تنظیمات سخت 

I 

I/O Buffer بافر ورودی/ خروجی 

J 

K 

L 

License مجوز 

Logic منطقی 
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Logic Cell سلول منطقی 

M 

Manage مدیریت 

Map ترسیم 

Megafunctions توابع اصلی 

My Computer کامپیوتر من 

N 

Netlist Viewer نمای لیست گره 

Next بعدی 

Node Finder ی گره یابنده 

O 

OK تایید 

Others غیره 

Output File فایل خروجی 

P 

Place جایابی 

Primitive پایه 

Program ریزی برنامه 
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Project پروژه 

Properties ها ویژگی 

Q 

R 

Route مسیریابی 

RTL Viewer نمای سطح انتقال ثبات 

S 

Schematic شماتیک 

Start شروع 

State Machine Viewer نمای ماشین حالت 

Symbol Tool ابزار نماد 

T 

Target Device دستگاه مقصد 

Technology Map Viewer  تکنولوژی ترسیمنمای 

Timing بندی زمان 

Translate ترجمه 

U 
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Update به روز رسانی 

V 

Verification سنجی درستی 

W 

X 

Y 

Z 

 


